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System Requirements 
¶ Microsoft Windows 2000, XP, Server 2003 or Vista (32 or 64bit). 

¶ 20 Mb of free Hard Disk Space. 

¶ Adobe Acrobat Reader to access the CD version of the tutorial. 

¶ We recommend that all the latest critical updates are installed 

from: http://windowsupdates.microsoft.com 
Note: The mimics in the Flowol 3 package will also be installed.  The óBig Wheelô and óCot Mobileô are 

new F3D mimics which have 3D animations.  The speed of the animation will depend on the graphics 
capability of your computer.  One way to speed up slow animation, at the expense of image quality, is to 

remove the check mark from the óUse anti-aliasingô option in the Mimic tab of the Options dialog from 

the Settings menu. 

 

Installing Flowol  
¶ Insert the Flowol 3.10 CD ROM into the CD Drive. 

¶ This is an auto play CD ROM, which means that Windows should detect the presence of the 

CD and automatically start up the Auto run program.  

¶ Follow the on-screen instructions to complete the installation of the Flowol and its 

associated files onto the hard disc.  

¶ When installation is complete, eject the CD ROM and store safely. 
Note: If the Auto run program fails to start, use Windows Explorer to navigate the CD ROM contents and 

double click on the file Setup.exe. 

[See p.33-37 for installation onto Windows and RM networks]  

Impor tant Notes: 

1. When using the Mimic Creator after installing Flowol3, you will need to use the óSet Mimic 
Directory..ô in the Mimic Creatorôs file menu each time you need to access the 2D mimics. 

Or transfer the mimics as explained above if you need to access them by default.  
 

USB Users: Ensure that the interface is NOT connected when the Flowol software is installed.  If you 

have installed the FlowGo/Solo drivers with a previous version of Flowol, uninstall them first by going to 

the Add or Remove programs control panel and remove the óFlowGo/Solo USB Drivers (Flowol 2.91)ô 
program. 

 

  



 

 

Tutorial Primary/Secondary 

 

Page 4 © Keep I.T. Easy 2008 Flowol 

Flowol 

 

Getting Started  
To start the Flowol software once it has been installed: 

1. Click on the Start button on the taskbar. 

2. Within Programs, select Flowol 3 and click on the Flowol 3 icon. 

 

Configuring Flowol  

Flowol can operate with or without an interface attached. If the óNo Interfaceô option is selected, 

Flowol will automatically be in simulation mode with the maximum number of inputs and 

outputs available. If an Interface has been selected from the list then Flowol can operate either: 
 

¶ Without the interface connected,  open (in simulation mode), so that the correct 

number of outputs, inputs and commands are available for that interface.  

¶ Or: with the interface connected,  closed (interface in operation). 

 

The following interfaces are supported: 

 

Data Harvest: Contact Controller Plus 

   Contact Controller 

   FlowGo [Serial/USB] 

   Solo 
 

Fischertechnik: Robo [Serial/USB]   

  Intelligent Interface [Serial] 
 

Deltronics: Serial Interface 

   Serial Interface + 

   Junior Interface 

   Extra Sense [Serial Interface] to operate the Control IT Buffer Box. 

   Digital Serial Adapter: to operate the Control IT Buffer Box. 

   Control and Data Capture Interface [USB] 

 

 Economatics: Smart Box 

   Control Station 
 

Commotion: Serial Interface 

   Junior Interface 

   Commotion CoCo [USB] 
 

LEGO DACTA: (Control Lab) Interface B 

 

PICAXE 

 

FlowIC 

 

Other interfaces may be added in the future and available for download from the website.   

http://www.flowol.com/flowol3/interfaces.aspx 

http://www.flowol.com/flowol3/interfaces.aspx
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Setting up Flowol for your Interface: 
¶ Open the Settings menu and select óInterfacesô to open the óChoose Interfaceô window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

¶ Select your interface from the list shown and wait a few moments until its picture is 

displayed. 

o If your interface is USB connection only, there will be no further options. 

o If there is a dropdown menu you will need to select the appropriate 

communication port. E.g. an available COM port for Serial connection, or the 

USB. 

o Select the labeling (0 ï 7) if required.  [Note: the Tutorial is written for the 1 ï 8 

setting]. 

o If you are using the Digital Serial Adapter or Extra Sense, the interface connected 

to it might need to have the óHighô selected.  

 

¶ Click óSave settings and OKô if you would like this selection to be automatically 
configured when Flowol is next used.  Click óOKô for these settings to be used for this 

session only. 

¶ The program should now detect the interface if it is connected to the computer.  The

 [connecting plug icon] will flash and close [interface in operation].  To work in 

simulation mode, click on the icon to open the connection. 

 

Note:  Some interfaces have restrictions on the number of inputs, outputs and motors available, 

which will not always match the labels on the mimics.  When the óNo Interfaceô option is 

selected, Flowol will have the maximum number of inputs and outputs available but will only 

work in simulation mode.  These can be changed with the óAdvancedô option. 

 

Mimic Options:  Some 3D mimics can be re-labeled to suit the userôs interface.   
 

E.g. after configuring for the interface, open the óMobileô 

mimic and select óMimic Optionsô from the Mimic menu.  

The user now has the options of changing the óValô label and  

the use of Motor B.  These changes will be saved by Flowol 

in the .flo file with the flowchart.  
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The Tutorial  
 

Introduction  
This tutorial introduces Flowol software and the flowchart method of creating a control program.  

It is a hands-on approach which puts the reader through a series of problem solving exercises.  

Each exercise uses a control program to explore different elements of control, starting with 

simple ideas and progressing to more complex examples.  The features of Flowol are introduced 

gradually at each stage. 
 

Using the Tutorial 
[The tutorial, also on the Flowol CD, will be installed automatically so it can be accessed from 

the óHelpô menu]. 

 

Pages 7 to 20 are an appropriate introduction for all students.  Since the examples are 

progressive, you can decide how far your students should go.  Each theme in the tutorial gives 

direction to possible solutions, and several of the pages can also be used as worksheets.  Ideas 

should be transferred from one section to another and extended to provide a complete solution. 

 

It might also be useful to refer to the Studentôs Activities available on the web site.  These 

activities are a pupil based text to support parts of the Flowol tutorial and also the extra Primary 

and Secondary Mimic Discs.  The controllable tasks are progressive, similar to those in the 

tutorial, but focus more on the problem solving aspects of the examples rather than acquiring the 

skills to use the software. 

Extra mimic packs are available, check http://www.flowol.com for details. 
 

Why Flowol? 
Flowol is normally set to operate in simulation mode.  This allows all students on a computer to 

actively create, test and refine their control solutions.  The mimics are controllable pictures 

which respond in a realistic way and the visual activity of the flowchart allows the logic to be 

easily followed and amended. 

 

When models are connected and operated through a control interface, the mimics still respond. 

Readings from analogue sensors can also be logged and used to control events.  The computer 

screen then also becomes an important monitoring tool.  Industrial processes, security systems 

etc. are often monitored in a similar way. 
 

 

Copyright: all rights reserved.  This tutorial may be copied for use within the premises of the 

licensee on the condition that it is not loaned or sold. 

 

Keep I.T. Easy acknowledge that there may be error or omission in this publication for which 

responsibility cannot be assumed.  No liability will be accepted for loss or damage resulting from 

the use of information contained in this tutorial or from uses as described. 
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Flowol Control and Data Logging 
 

 

 The Screen: 
 

 

The Workspace 
The Flowol workspace is the area of screen 

available to build the flowchart program.  

This initially has a size of 4 pages, capable 

of holding 220 symbols, but these 

dimensions can be changed. 

 

The Toolbar 

i)  Click on a Tool/symbol to select it. 

ii)  Click again on the workspace to 

position it. 

iii)  A prompt box will appear at the 

bottom of the window.  It contains 

all the items that can be entered into 

that symbol.   

  

Mimics 

These are controllable pictures which 

allow the programs to be developed and 

tested in óSimulateô mode. 

Graphs 

i) Analogue and digital inputs can be 

logged as a separate application. 

 

ii)  Inputs and outputs can be plotted 

together to show the response of the 

controlled outputs. 
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The Tools / Symbols 
Erase/Delete 

 
 

The Erase Tool will highlight and become active when part of the 

flowchart has been selected for editing. 

Start/Stop/Sub 

 

Use the Start symbol at the beginning of the flowchart program. 

Use the Stop symbol at the end of a subroutine, and at the end of a program 

which is not recursive (repeating). 

Use the Sub symbol to head a subroutine. (Note: subroutines should be 

defined before the main program). 

Use the prompts to make your selection. 

Output  

 
 

Use the Output  symbol to turn on or turn off an output or a motor. 

Use the prompts to make the selection. (Note: all the outputs or all the 

motors can be turned on or off within one symbol). 

Process 

 
 

Use the process symbol to put in a delay. (e.g. how long the output needs to 

be switched on for). 

This is also used to call up a subroutine, or to set up a variable.  Use the 

prompts to make your selection. 

Decision 

 

Use the Decision symbol to decide if óYes do thisô or óNo do thatô. 

For example, it can be used to check for feedback from an input signal such 

as: is the switch on; or is the temperature value more than, less than or 

equal to x?  This symbol can also be used to check the values of a variable.  

Use the prompts to make your selection. 

Text 

T 

Click on the Text Tool to add a title, or comments on the flowchart.  Click 

on the workspace to position the text window.  Type in the text window that 

appears on the workspace.  Edit the text with the font toolbar at the top of 

the screen 

Edit  

 

Click on the Edit Tool (or use right mouse button) when you need to 

highlight symbols, lines, labels or section of flowchart.  They can then be 

erased, changed or moved. 

 Use the Line Tool to link the symbols together to create the flowchart. 

Where a decision symbol has been used, then both a YES and a NO line 

have to be used. [The Yes/No selection box appears when you first click on 

the decision symbol]. e.g. If switch is pressed (Yes) - do something. 

If switch is not pressed (No) - go back and check again. 

 

Start / Stop button to run or stop the program. 

 

Interface connection.  E.g. if configured for an interface you can switch 

between simulation mode and interface operation mode. 

Note: a óRemoteô tool will become available when configured for FlowGo, 

Solo or PICAXE 
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An All -Stop road intersection  
  

To run this short program, click on the  symbol in the toolbar.  To stop the program click 

on the symbol again [note: in this example it may stop automatically at the end of the 

sequence]. 

Program: 

1 Select the Start symbol óToolô and click again on the workspace to position 

and fix the gray image of the symbol.  Use the prompts to select Start. 

 

2 Select an Output  symbol ï position it 

under the Start symbol. Use the prompt 

to Select: Turn Output 1 on, 

click on OK. 

 

3 Select a Process symbol ï position 

it under the Output symbol. Use the 

prompts to select Delay 5 Click OK. 

 

4 Select the Output  symbol ï position it under the symbol above.  Use the 

prompts to select Turn Output 1 off . Click OK. 

 

5 Select a Stop symbol ï position it under the symbol above.  Use the prompts 

to select Stop. 

 

6 Select the Line tool to link the symbols 

i) Click on the óStartô symbol (it will highlight green). 

ii)  Click on the symbol beneath it. (The line will be drawn). 

iii)  Click on the second symbol again. (This is the start of the next line) 

iv)  Click on the third symbol etc and continue until the flowchart is 

complete. 

  

   

Skill:  To connect three of the basic flowchart óToolsô to create a 

control program to turn output 1 on for 5 seconds, then turn it off. 

To open up the mimic: click on the mimic 

icon on the Toolbar. Choose óAll Stopô.  To 

show the labels, click on the label icon. 

 

Note: If you already have Flowol 2 mimics in 

another folder, select óFlowol 2 mimic folderô 

in the Mimic window.  Browse and select your 

old Flowol 2 mimic folder. 

 

To test the action of the mimic: click on the 

light on the mimic to turn it on, click again to 

turn it off.  RUN your program again. 

 

To save a program: open the File menu, then 

click on Save As... give your program a 

filename [e.g. óallstopô], OK 

 

  

Start

Turn

Output 1 on

Delay 5

Turn

Output 1 off

Stop

Mimic  

óAll Stopô 

Resource 

6V bulb connected to Output 1 

 



 

 

Tutorial Primary/Secondary 

 

Page 10 © Keep I.T. Easy 2008 Flowol 

Flowol 

Changing and Adding Instructions.  

  

Multiple outputs  can be triggered in the same output box by simply selecting as many as you 

wish in the prompt box.   
 

 

Skill:  To modify a flowchart  

i) Remove unwanted symbols 

ii)  Changing information in the symbols 

iii)  Inserting extra symbols in a sequence 

iv) Have multiple outputs in a symbol 

Moving the prompt box 

 

 

Mimic  
óAll Stopô and óCrosswalkô 

Resources 
6V bulb connected to outputs 1 & 2 

Removing a mistake:  

Symbols or lines in the wrong place can be removed. 

Select the edit tool (Hand). Note: the right mouse button is an edit Short-cut, instead of 

clicking on óHandô 

Click on the incorrect line or symbol to highlight it, and then click on  at the top of 

the toolbar. 

  

 
Changing Information e.g. delay time 

1 Select the edit tool (Hand) 

2 Click on the óDelayô in the 

flowchart, to highlight it. 

3 Click on óCô on the prompt box 

number pad and change it to 2. OK. 

 

Inserting Additional Symbol:  
1 Select another process [delay] 

symbol from the toolbar. 

2 Place the orange image on the line 

above the Stop symbol.  The chart 

will automatically re-draw itself. 

3 Use the prompt box to produce: 

Delay 2, OK 

 

To make the óAll Stopô flash forever 

(recursive): 

1 Select Edit tool, click on the Stop 

symbol and erase it with        tool. 

2 Now draw a line from the second 

Delay to the process symbol at the 

top which turns output 1 on. 

Run and Save this new program ï. 

 

Now load the óCrosswalkô mimic and 

modify your óall stopô routine [see Multiple 

outputs below] so that the lights (outputs 1 

& 2) flash alternatively. 

Run and Save your program ï  

 

 

 

 

 

 

 

Start

Turn

Output 1 on

Delay 2

Turn

Output 1 off

Stop

Start

Turn

Output 1 on

Delay 2

Turn

Output 1 off

Stop

Start

Turn

Output 1 on

Delay 2

Turn

Output 1 off

Stop

Delay 2

Change delay

Insert extra process

Erase this stop & draw new line

 

Move the prompt box if it is in the way 

by dragging it with its shortened title bar 

on the left hand corner. 
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Traffic Lights  

Move the prompt box if it is in the way 

by dragging it with its shortened title bar 

on the left hand corner. 
 

Mimic  
óIntersection Lightsô 

 Resources 
Output 3 ï 6V bulb 

Output 2 ï 6V bulb 

Output 1 - 6V bulb 

Etc.  

 

Skill:   Putting Text on the flowchart  

Simulations with monitor Toolbars. 

 Editing the information in a symbol. 
 Printing the flowchart. 

  

Simulation without a mimic. 

Flowol has monitor toolbars which are normally at the bottom of the workspace.  

They can be moved by dragging them around the screen.  When in the workspace, they become 

windows which can then be closed.  They can be re-opened from óToolbarsô-View menu.  

 

These monitor bars show the state of the inputs and outputs. 

When the program is in simulation mode, the input can be clicked on to simulate the input changing. 

 

Traffic Lights:  

Let Output 1 be green, Output 2 - amber and Output 3 - red and build up the flowchart shown below.  
 

 

 
 

 

To Edit the instructions in a symbol:  re-select 

the symbol on the workspace [highlight blue] to 

re-open its prompt box 

Note: If the symbol is already selected but the 

prompt box is not open, then you need to click on 

the workspace first; and then click on the symbol 

again. 

Click on the options in the prompt box to make the 

changes.  E.g. to change an On to an Off, just click 

on the Off [they will toggle].  To remove the On 

altogether just click on it again.  Note: When 

starting a new column always work downwards. 

 

Run the program.  Note: the light sequence is not 

quite right. Make the correction and save your 

program . 

 

To print  the flowchart,  click on 

the printer icon on the top toolbar.  [See details 

about the full printing options on page 25]. 

Labeling the Flowchart: 

1 Select the Text Tool, position and click the óLabelô window on the flowchart.  

2 Re-write the label in the text window. 

3 Edit the font by using the Font toolbar.  

4 Labels can be moved in a similar way to that of the symbols [click once on the label]. 

5 To edit the text in the label, double click on the label or click once on the label to highlight it, 

and then click on the Text edit icon.  
 

 

Start

Turn

Output 3 on

Delay 7

Turn Output

2 on 3 off

Delay 3

Turn Output

1 on 2 off

Delay 7

Turn Output

2 on 1 off

Delay 3

Turn

Output 2 off

Traffic Lights

 

 

Text edit icon 
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Double Set of Traffic Lights   

  
 

 

  

 

Skill:   
i) Changing the scale of the flowchart  

 ii ) Undo and Redo 

iv) Click on the mimic to test its function. 

v) Slowing down the flowchart 

  

Mimic  
óIntersection Lightsô 

Resources 
Outputs (1 to 6) ï 6V bulbs 

 

Testing the Outputs on the Mimics: 

 

Display óIntersection Lightsô mimic and show 

the labels . 

If you carefully click on each of the lights on 

the mimic, you will make them turn on; click 

on them again to turn them off.  Also observe 

the output monitor bar.  Now click on the 

outputs on the monitor bar to see the effect on 

the mimic. 

Run the Traffic Lights program and check it 

out on the mimic.  Change/edit the delays until 

you have the best result. 

 

 

 

 

 

 

Double Set of Traffic Lights 

This can be done by either constructing another flowchart for the second set of lights, or by 

modifying the sequence for the single set of lights. [e.g. insert extra symbols or edit some of those 

symbols already there].  Run the program and observe the effect on the mimic so your program 

can be checked and refined.  Save your new program. 

 

 

 

 

 

 

 

 

 

Re-scaling [Zoom] the flowchart.  When the flowchart becomes too large to be 

seen in one frame, use zoom to observe more symbols on the monitor screen.  [80% 

is a useful, readable size].  The Zoom default can be changed from óOptionsô in the  

Settings menu. 

Symbol Tooltips:  Having < 80% is useful when re-arranging the flowchart but the 

symbols are difficult to read. Tooltips will appear [if Zoom<80%] when the cursor 

hovers over a symbol.  These Tooltips can be turned off from the View menu. 

Undo and Redo can be used to step back and then forward 

again through the stages of creating the flowchart. 

Reducing the Speed of the Flowchart or Stepping Through the Program is useful when 

demonstrating or checking for errors.  Open the Speed toolbar from óToolbarsô in the View menu. 

Make the speed adjustment by 

moving the slider.  The óspeed toolô 

window can be closed or dragged to 

the top or bottom toolbars. Slow-Fast 

To step through the program, first pause the flowchart  

by clicking on the icon [or from Settings menu] and then step 

from one symbol to the next using the Spacebar or step icon. 
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The Lighthouse 
  

Skill:   To use multiple flowcharts: 

i) Move sections of flowchart. 

ii)  Copy a flowchart. 

iii)  Changing the color of the flowchart. 

iv) Controlling a model through a control box. 

Mimic  
Light House 

 

Resources 
Output 2 - buzzer 

Outputs 1 & 3 ï 6V bulbs 

 

Open the Light House mimic, re-load the óallstopô program, from the earlier example, 

and run it to observe the effect on the mimic.  Stop the program again. 

 

Try moving Sections of flowchart: (individual symbols or groups of symbols) 

 

1 Select the edit tool (hand). 

2 Click on the symbol in the flowchart to be moved and it will highlight. 

3 Use the left mouse button to drag the symbol and then release. 

4 To highlight a group of symbols, drag a box around the group. (Click left 

mouse button at one corner of the group, drag a box across them and release).  

5 Select any one of the highlighted symbols to drag the group. 

6 Move the group back or use Undo. 

Controlling the Foghorn on the lighthouse: 

Copy the flowchart: 

Select edit tool and highlight the 

flowchart by dragging a box around it. 

(explained above). 

 

i)  Hold the Shift key and drag one of the 

highlighted symbols to drag a copy of 

the flowchart to one side, release mouse 

button. 

ii)  OR: use the Copy and Paste  

icons.  See details of Cut, Copy and 

Paste on page 17. 

 

The outputs in the second flowchart now need 

to be re-defined as Output 2.  

 

It may also be advisable to change the delays: 

Delay 1 when buzzer is óonô and Delay 3 when 

óoffô. Save the ólighthouseô program. 

Connecting to an Interface and controlling a model: 

If Flowol is configured for an interface [see p.5] and your control box is connected to the 

computer, you can switch from simulation mode to interface mode by closing the plug connector 

icon on the toolbar e.g.  to  or vice versa to return to simulation mode. 

 

 

 

 

To change the colors of the flowchart: select óColorsô from óOptions..ô in the Settings menu.  

Note: stronger colors may be useful for demonstrations but strong, flashing colors can be 

unpleasant for the user, or even dangerous for some users who suffer from epilepsy.  

Start

Turn

Output 1 on

Delay 2

Turn

Output 1 off

Delay 2

Start

Turn

Output 2 on

Delay 1

Turn

Output 2 off

Delay 3

Main Light
Fog Horn
(buzzer)

Output 1 to 2

Change the Delays
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Lighthouse with a switch  

Skill:   Using an Input (Decision) symbol. 

  
  

Mimic  
Light House 

Resources 
Output 3 ï 6V bulb 

Output 2 ï Buzzer 

Output 1 ï 6V bulb 

Input 1 ï switch or LDR 
 

Using an input switch to control the interior light in the lighthouse: 

An input is observed by a decision symbol.  When the program is running the decision 

instruction ólooksô for a fraction of a second to see if the input is On or Off. 

 

The diagrams below show the steps needed to build the procedure for the interior light program.  

 

Create and position these four symbols.  When you click on the decision symbol to draw the first 

line it will highlight the symbol [green] and open a window for you to decide if this first line is to 

be a YES or NO line.  Make your decision (e.g. YES) and then click on the destination symbol [Turn 

Output 3 on].   When you highlight the decision symbol for the second line, the program will 

already know it is for the NO line.  Click on the destination symbol [Turn Output 3 off].  Add the 

extra lines to complete the flowchart.  Write some labels and Re-Save the program. 

Using a light sensor as the switch. 

A light sensor is On when it is light and Off 

when it is dark. 

 

Run the ólighthouseô program and click on 

the Moon/Sun (input 1) on the mimic. This 

will  simulate the effect of changing the light 

sensor. 

 

Now insert decision symbols to the other 

flowcharts so that the main light and foghorn 

are also controlled automatically by the 

daylight. 

Test your program and re-save it. 

 

 

  

Start

Is Input 1 off

Turn

Output 3 on

Turn

Output 3 off

YES

NO
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Lighthouse with Subroutines and Sound 
 
 

   
 

Subroutines 

When a section of flowchart needs to be repeated, it is better to use a subroutine and a separate 

main routine to command this subroutine. The subroutine however, must be defined and drawn 

first, so it can be selected and included in the main routine. 

[In the lighthouse example we can use a subroutine to give the flashing light a signature].  

 
 Building a subroutine:  Select the óStart symbolô but click on Sub (not 

Start) in the prompt box.  Write the name óflashô in the text window and 

click OK. 
 

 

Turn

Output 1 on

Delay 1

Turn

Output 1 off

Delay 1

Sub flash

Stop

The flowchart for the subroutine can then be built up in the usual way 

but it should finish with a óStopô 

Start

Is Input 1 off

Sub flash x 2

Delay 3

YES

NO

Building the main routine: 

Draw the main routine (with a óStartô).  After 

selecting the process symbol, click on óSubô in the 

prompt box. A list of your subroutines will appear. 

Make your selection.  

 

To repeat this subroutine, click on the number pad 

before clicking on OK. [e.g. óflashô repeated twice]. 

 
You can now modify the main routine by adding delays and calling up the óflashô subroutine 

in different ways to give the flashing light a different flashing routine [e.g. a signature]. 
 
Adding a fog horn sound to your lighthouse program. 

One of your flowcharts should be controlling the foghorn output 2.  Insert another output symbol  

below the one in the foghorn flowchart which turns Output 2 on. 

When the prompt box opens, choose Sound and type C:\WINDOWS\Media\ringout.wav  in the prompt 

box window to select the óringoutô sound file already on your computer.  Alternatively this can also 

be found by clicking on Browseé and locating the file.  Click OK in the prompt box. 

Note: If you use Browse, you may then have to re-locate your .flo files folder before saving. 

See details óUsing Sound on PC Flowolô [p.16], particularly if you wish to create your own sound. 

 

[Extension task: Use the óCrosswalk 2ô mimic to build a program using inputs, subroutines and 

sound]. 

 

 

 

Run what?: allows you to run a subroutine or selected 

flowcharts on their own. 

Select óRun what?ó from the Settings menu.  Choose your 

named subroutine from the list, and RUN the program. 

Or choose óSelectionô; highlight the chosen Start [or Ctrl and 

select several Starts] on your flowchart and RUN.   

Remember to choose óAll Startsô again at the end of the test. 
 

Skill:  Using Subroutines 
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Play        Stop 

Recording your own sounds: 

¶ Attach a microphone and speaker to the sound card. 

¶ Open the Flowol program. 

¶ Launch Microsoftôs Sound Recorder by clicking on the  icon  [Note: This óSound 

Recorderô can then be re-accessed from the lower taskbar]. 

¶ Click on the Record button to start a recording.  Make your sound into the microphone.  

Click on the Stop button when the recording is complete. 

¶ Only edit the sound if you need to.  (E.g. you might need to delete a bit of recording just 

before or after the section of sound you need). To do this, move the slider on the Recorder 

window to identify the beginning and end of the sound, and use the Edit menu on the 

Recorder to delete the unwanted sections of recording. 

¶ Select Save As from the Sound Recorderôs File menu.  Save as a .WAV file type in the 

destination of your choice but it may be best to save it in the same area that stores your 

flowchart .flo files. 

 

¶ To use the sound in your flowchart program  insert an output symbol .  Select 

Sound from the prompt box and Browse.. for your .wav file and click OK.  In the foghorn 

example above we wanted the sound to run with the visual fog horn on the mimic and 

therefore did not select the óWait for sound to finishéô in the prompt box.    

Using Sound on PC Flowol 
[For PC computer only with sound card, microphone and speakers connected] 

 

Sound can give extra realism to the control situations for example the foghorn on the 

lighthouse.  In automatic systems such as crosswalks and elevators sound is also frequently 

used to help the partially sighted cope more easily. 

 
To record new sounds or listen to 

the pre-recorded sounds on your 

computer [at C:\WINDOWS\Media\...] 

you need to open the Windows 

Sound Recorder by clicking on the  

Sound Recorder icon  [menu bar 

or Sound prompt box].  
 

Length of 

time of the 

recording 

Record 

¶ Note: Although flowcharts can run simultaneously sounds cannot.  If a sound is initiated 

by one routine, then it may be interrupted or cancelled out by sound from another routine. 

 

¶ When the sound file has been used in a Flowol program and the Flowol  .flo file saved, the 

location of the sound .wav file is also saved but not the sound itself.  If you transfer or 

open the Flowol file on another computer you may have to either: 

o Transfer the sound file to the location specified by the Sound prompt box or 

o Use óBrowseô in the Sound prompt box to re-locate the sound file, click OK in the 

prompt box to save this location in your program and re-save the Flowol .flo file. 
 

If we want the sound to finish 

before the program continues 

[i.e. describing something], 

select óWait for soundéô in the 

prompt box before clicking OK.  
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Using Copy and Paste  

Flowcharts can be copied from Flowol3 and pasted into: 

¶ the same Flowol3 application. 

¶ a different Flowol3 application. 

¶ a word processor (e.g. Microsoft Word) for a report or worksheet. 

 

 

 

Stage 1:  

¶ Drag a box around the section of flowchart to be copied to highlight it blue. 

¶ Click on the copy icon. 

Either Stage 2:  

¶ Click on the paste icon. 

¶  Move the gray ghost 

image to the new place 

on the workspace and 

click to fix it. 

 
 
OR Stage 2: 

¶ Click on the paste icon 

in the new application. 

¶ Move the ghost image to 

the new place on the 

workspace and click to 

fix it.  

OR Stage 2: 

¶ Click on the paste icon in Micro soft Word . 

¶ Click on the image; click on the óText Wrappingô 

icon  and select Square. 

¶ Drag the image to a smaller size and position it. 
 
To copy a mimic into Microsoft Word:  

Stage 1: 

In Flowol, click on the mimicôs title bar; press óAlt  

Prt Srô and follow stage 2 above.  

After a flowchart has been copied 

back into Flowol: 

¶ Edit the commands in the 

symbols to suit the new context. 

¶ Note: the subroutine title will 

have changed automatically, since 

a program must not have two 

different subroutines with the 

same name. 

Ghost image is red if too 

close to other symbols. 


